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Part 1: User Journey Mapping 

 

Introduction 

Welcome to the AMIS Evaluator Tutorial. As an Evaluator (also called M&E Officer - Monitoring and 

Evaluation Officer), you have a dual role: you can create and implement your own activities like a Regular 

User, AND you provide independent quality assessment and rating of approved activities across the entire 

system. This tutorial will guide you through both aspects of your role. 

Your Role and Responsibilities 

As an Evaluator / M&E Officer, you are responsible for: 

 Independent Evaluation: Providing objective assessment of activity quality and effectiveness 

 Activity Rating: Rating approved activities on a scale of 0-100% 
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 Quality Assessment: Evaluating implementation quality, evidence, and impact 

 Feedback Provision: Providing constructive feedback to improve future implementation 

 Performance Measurement: Assessing achievement of activity objectives 

 Data Quality Verification: Ensuring accuracy and completeness of activity data 

 Activity Implementation: Creating and implementing your own activities (like Regular Users) 

 Results Documentation: Recording evaluation findings and recommendations 

Your Dual Role 

As an Implementer (Regular User Capabilities): 

 Create and implement your own activities 

 Submit your activities to YOUR supervisor for approval 

 Complete duty instructions assigned to you 

 View reports on your own activities 

As an Evaluator (Evaluation Capabilities): 

 Access ALL workplans across the system for evaluation 

 View ALL approved activities regardless of branch or supervisor 

 Rate activities based on quality, evidence, and impact 

 Provide evaluation feedback and recommendations 

 View evaluation reports and statistics 

 Conduct independent quality assessment 

What You Can Do 

 All Regular User Features: Everything a Regular User can do 

 Access All Workplans: View all workplans system-wide for evaluation 

 View All Approved Activities: See activities approved by any supervisor 

 Rate Activities: Provide percentage-based rating (0-100%) 

 Provide Evaluation Feedback: Give detailed remarks on quality and effectiveness 

 Update Ratings: Revise ratings if needed 

 View Evaluation Reports: Access reports on evaluation activity 

 Independent Assessment: Evaluate objectively without bias  

What You Cannot Do 

 Evaluate Your Own Activities: Your activities are evaluated by other evaluators 

 Approve Activities: Only supervisors can approve activities 

 Create Workplans: Only administrators can create workplans 
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 Manage Users: Only administrators can manage user accounts 

 Access Admin Panel: Administrative functions are restricted 

 Manage SMEs: Only administrators can manage SMEs 

 Rate Unapproved Activities: Only approved activities can be rated  

System Goal 

The primary objective of AMIS is to monitor and measure the effectiveness of activities implemented 

and how they contribute to achieving the targets in the plans. 

Your role as an Evaluator is crucial because you: 

 Provide independent quality assessment of activities 

 Measure effectiveness and impact achieved 

 Verify data quality and accuracy 

 Identify best practices and lessons learned 

 Support evidence-based decision making 

 Enable continuous improvement through feedback 

 Ensure accountability for results 

Evaluation Principles 

Independence: 

 Evaluate objectively without bias 

 Not involved in implementation or supervision of activities you rate 

 Provide honest assessment based on evidence 

Objectivity: 

 Use consistent criteria across all activities 

 Base ratings on evidence, not assumptions 

 Apply fair and transparent standards 

Constructiveness: 

 Provide feedback that helps improve future implementation 

 Recognize good practices and achievements 

 Suggest practical improvements 

Evidence-Based: 
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 Rate based on documented evidence (photos, documents, data) 

 Verify beneficiary data and costs 

 Assess quality of implementation 

 

Login Process 

Step 1: Access the AMIS Application 

1. Open your web browser (Chrome, Firefox, or Edge recommended) 

2. Navigate to the AMIS URL: http://your-amis-url.com (replace with your organization's URL) 

3. You'll see the AMIS Login page 

Step 2: Enter Your Credentials 

1. Email Address: Enter your registered email address 

2. Password: Enter your password 

3. Click the "Login" button 

Step 3: Successful Login 

Upon successful login: 

 You're redirected to your Dashboard Landing Page 

 You see a welcome message with your name 

 Your role badge shows "User" with "Evaluator" capability indicator 

 The sidebar navigation menu appears with your accessible features 

 You'll see the "Evaluation" menu item (evaluator-specific) 

Troubleshooting Login Issues 

Problem: "Invalid email or password" 

 Solution: Check your email and password are correct 

 Solution: Ensure Caps Lock is off 

 Solution: Contact your administrator to reset your password 

Problem: "Account not activated" 

 Solution: Check your email for activation link 

 Solution: Contact your administrator to activate your account 
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Problem: "Session expired" 

 Solution: This is normal after 2 hours of inactivity 

 Solution: Simply log in again 

Security Best Practices 

 Change your password on first login 

 Use a strong password (at least 8 characters, mix of letters and numbers) 

 Don't share your password with anyone 

 Log out when finished, especially on shared computers 

 Report suspicious activity to your administrator 

 Maintain confidentiality of evaluation findings 

 

Dashboard Overview 

After logging in, you land on your Dashboard Landing Page. As an Evaluator, your dashboard shows both 

your personal activity metrics AND your evaluation responsibilities. 

Dashboard Layout 

Top Section: Welcome Card 

 Welcome Message: "Welcome back, [Your Name]!" 

 Role Badge: Shows "User" with "Evaluator" indicator 

 Current Date and Time 

Main Section: Dashboard Widgets 

The dashboard is organized into cards showing your key metrics: 

1. My Activities Card 

 Total Activities: Count of all YOUR activities (that you created) 

 Pending: Your activities you haven't implemented yet 

 Active: Your activities you're currently implementing 

 Submitted: Your activities awaiting supervisor approval 

 Approved: Your activities approved by supervisor 

 Rated: Your activities evaluated by another evaluator 

 Quick Action: "Create New Activity" button 
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2. Evaluation Activities Card (Evaluator-Specific) 

 Total Approved Activities: Count of all approved activities system-wide 

 Pending Rating: Approved activities not yet rated (PRIORITY) 

 Rated by Me: Activities you've rated 

 Average Rating: Average rating percentage you've given 

 Quick Action: "View Activities to Rate" button 

3. My Tasks Card 

 Pending Tasks: Duty instructions assigned to you 

 Completed Tasks: Duty instructions you've finished 

 Quick Action: "View All Tasks" button 

4. Recent Evaluations Card (Evaluator-Specific) 

 List of your 5 most recent evaluations 

 Shows activity title, rating, and date 

 Quick Action: "View All Evaluations" button 

5. Evaluation Statistics Card (Evaluator-Specific) 

 Rating Distribution: Breakdown by rating range 

o Excellent (81-100%) 

o Good (61-80%) 

o Fair (41-60%) 

o Poor (0-40%) 

 Visual Chart: Pie chart showing distribution 

 Quick Action: "View Evaluation Report" button 

Using the Dashboard 

Quick Navigation: 

 Click "Create New Activity" to start a new activity 

 Click "View Activities to Rate" to see approved activities awaiting rating 

 Click "View All Tasks" to see your duty instructions 

 Click on any recent evaluation to view details 

Monitoring Your Responsibilities: 

 Check Pending Rating count to see activities needing evaluation (PRIORITY) 
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 Check My Activities Submitted count to see your activities awaiting approval 

 Review Average Rating to ensure fair and consistent evaluation 

 Monitor Rating Distribution to identify quality trends 

Priority Actions: 

1. First: Rate approved activities (don't let them wait) 

2. Second: Implement and submit your own activities 

3. Third: Complete your duty instructions 

4. Fourth: Review evaluation reports and trends 

 

Navigation Map 

As an Evaluator, you have access to 5 main menu items in the left sidebar navigation: 

1. Dashboard 

 Icon:  Dashboard icon 

 Purpose: Your personal workspace with metrics and quick actions 

 Access: Always accessible 

 Evaluator Feature: Shows evaluation metrics (pending ratings, rated activities) 

2. My Activities 

 Icon:  Activities icon 

 Purpose: Create, view, implement, and manage YOUR OWN activities 

 Submenu Items: 

o All Activities: View all your activities 

o Create Activity: Create a new activity 

o Pending Activities: Filter to show pending activities 

o Active Activities: Filter to show active activities 

o Submitted Activities: Filter to show submitted activities 

 Note: This is for YOUR activities, not activities you evaluate 

3. Evaluation (Evaluator-Specific) 

 Icon:  Evaluation icon 

 Purpose: Access workplans and rate approved activities 

 Submenu Items: 
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o All Workplans: View all workplans system-wide 

o Pending Rating: Filter to show approved activities not yet rated (PRIORITY) 

o Rated Activities: Filter to show activities you've rated 

o Evaluation Reports: View evaluation statistics and reports 

 Access: Only evaluators can access this menu 

 Note: This is the MOST IMPORTANT menu for your evaluation role 

4. Duty Instructions 

 Icon:  Instructions icon 

 Purpose: View and manage duty instructions assigned to you 

 Submenu Items: 

o All Instructions: View all your duty instructions 

o Pending Instructions: Filter to show pending tasks 

o Completed Instructions: Filter to show completed tasks 

5. Reports 

 Icon:  Reports icon 

 Purpose: View reports relevant to your work 

 Submenu Items: 

o My Activity Reports: Reports on YOUR activities 

o Evaluation Reports: Reports on your evaluation activity (Evaluator-Specific) 

o Statistics: View statistics dashboard (limited view) 

 Access: Similar to Regular Users with evaluation-specific reports 

Top Navigation Bar 

Right Side: 

 User Profile Dropdown: Click your name to access: 

o My Profile: View and edit your profile 

o Change Password: Update your password 

o Logout: Sign out of the system 

Navigation Tips 

 Sidebar is collapsible: Click the menu icon to collapse/expand 

 Active menu is highlighted: Current page is shown in different color 

 Breadcrumbs: Top of page shows your current location 
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 Back buttons: Use browser back or page-specific back buttons 

 Priority Menu: Check "Evaluation → Pending Rating" regularly 

 

Typical Workflows 

As an Evaluator, here are your most common workflows: 

Workflow 1: Rating an Approved Activity (MOST IMPORTANT) 

Scenario: An activity has been approved by supervisor and needs evaluation. 

Steps: 

1. Dashboard → Check "Pending Rating" count 

2. Evaluation → Click "Pending Rating" filter 

3. Select Workplan → View workplans with approved activities 

4. View Activities → Click "View Activities" on a workplan 

5. Select Activity → Click "View Outputs" on an activity 

6. Review Implementation → Check all details, evidence, beneficiaries 

7. Assess Quality → Evaluate based on criteria (evidence, impact, data quality) 

8. Rate Activity → Click "Rate Activity" button 

9. Enter Rating → Provide percentage (0-100%) and detailed remarks 

10. Submit Rating → Activity status changes to "Rated" 

11. Email Sent → Action officer and supervisor receive notification 

Timeline: Rate within 3-7 days of approval 

Best Practice: Provide detailed, constructive feedback in remarks 

Workflow 2: Updating a Rating 

Scenario: You need to revise a rating after further review or new information. 

Steps: 

1. Evaluation → Click "Rated Activities" filter 

2. Find Activity → Locate the activity you want to update 

3. View Activity → Click "View Outputs" 

4. Rate Activity → Click "Rate Activity" button again 

5. Update Rating → Modify rating percentage and/or remarks 
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6. Submit Rating → Updated rating is saved 

7. Email Sent → Action officer and supervisor receive notification of update 

Timeline: Update as soon as new information is available 

Best Practice: Explain reason for rating change in remarks 

Workflow 3: Evaluating Different Activity Types 

Scenario: You need to evaluate activities of different types with type-specific criteria. 

Steps: 

1. Access Activity → Navigate to activity for rating 

2. Identify Type → Note the activity type (7 types) 

3. Apply Type-Specific Criteria: 

o Documents: Quality, relevance, distribution 

o Trainings: Participant engagement, learning outcomes, follow-up 

o Meetings: Participation, decisions, action items 

o Agreements: Partnership value, sustainability 

o Inputs: Beneficiary reach, appropriateness, timeliness 

o Infrastructures: Quality, functionality, sustainability 

o Outputs: Achievement vs. target, quality, impact 

4. Rate Based on Criteria → Provide rating and remarks 

5. Submit Rating → Complete evaluation 

Timeline: Varies by activity type 

Best Practice: Use consistent criteria within each activity type 

Workflow 4: Creating and Implementing Your Own Activities 

Scenario: You need to implement an activity yourself (you're also an implementer). 

Steps: 

1. My Activities → Click "Create New Activity" 

2. Fill Activity Form → Enter details, location, dates, budget 

3. Assign Supervisor → Select YOUR supervisor 

4. Save Activity → Activity created with status "Pending" 

5. Implement Activity → Conduct field work 

6. Record Implementation → My Activities → View → Implement 
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7. Fill Implementation Form → Enter details, upload evidence 

8. Save Implementation → Activity status changes to "Active" 

9. Submit for Review → Submit to YOUR supervisor 

10. Wait for Approval → YOUR supervisor reviews and approves 

11. Another Evaluator Rates → Your activity is rated by another evaluator 

Timeline: Same as Regular User workflow 

Best Practice: Maintain high quality to set example for evaluation standards 

Workflow 5: Identifying Trends and Patterns 

Scenario: You want to identify quality trends across activities for reporting. 

Steps: 

1. Evaluation Reports → Access evaluation statistics 

2. Review Rating Distribution → Analyze ratings by range 

3. Identify Patterns: 

o Which activity types have highest ratings? 

o Which branches/supervisors have highest quality? 

o What common issues appear in low-rated activities? 

o What best practices appear in high-rated activities? 

4. Document Findings → Record trends and patterns 

5. Share Insights → Report to management for improvement 

6. Recommend Actions → Suggest training or support needs 

Timeline: Monthly or quarterly review 

Best Practice: Use data to drive continuous improvement 

 

User Journey Diagram 
┌─────────────────────────────────────────────────────────────────┐ 
│                         LOGIN PAGE                               │ 
│                    Enter Email & Password                        │ 
└────────────────────────┬────────────────────────────────────────┘ 
                         │ 
                         ▼ 
┌─────────────────────────────────────────────────────────────────┐ 
│                    EVALUATOR DASHBOARD                           │ 
│  ┌──────────────┐  ┌──────────────┐  ┌──────────────┐          │ 
│  │ My Activities│  │  Evaluation  │  │   Recent     │          │ 
│  │              │  │  Activities  │  │ Evaluations  │          │ 
│  └──────────────┘  └──────────────┘  └──────────────┘          │ 
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│                    ┌──────────────┐                             │ 
│                    │PENDING       │  ← PRIORITY!                │ 
│                    │RATING: 12    │                             │ 
│                    └──────────────┘                             │ 
└────────┬────────────────┬────────────────┬───────────────────────┘ 
         │                │                │ 
    ┌────▼─────┐    ┌────▼─────┐    ┌────▼─────┐ 
    │   My     │    │Evaluation│    │  Duty    │ 
    │Activities│    │(Rate     │    │Instructions│ 
    │(Create & │    │Activities)│   │          │ 
    │Implement)│    │          │    │          │ 
    └──────────┘    └────┬─────┘    └──────────┘ 
                         │ 
                         ▼ 
    ┌────────────────────────────────────────┐ 
    │  ALL WORKPLANS (SYSTEM-WIDE)           │ 
    │  - Workplan 1 (Branch A)               │ 
    │  - Workplan 2 (Branch B)               │ 
    │  - Workplan 3 (Branch C)               │ 
    └────┬───────────────────────────────────┘ 
         │ 
         ▼ 
    ┌────────────────────────────────────────┐ 
    │  VIEW ACTIVITIES IN WORKPLAN           │ 
    │  Filter: APPROVED (ready for rating)   │ 
    │  - Activity 1 (Training) - Approved    │ 
    │  - Activity 2 (Input Dist) - Approved  │ 
    │  - Activity 3 (Meeting) - Approved     │ 
    └────┬───────────────────────────────────┘ 
         │ 
         ▼ 
    ┌────────────────────────────────────────┐ 
    │  VIEW ACTIVITY OUTPUTS                 │ 
    │  - Review implementation details       │ 
    │  - Check evidence (photos, docs)       │ 
    │  - Verify beneficiary data             │ 
    │  - Assess quality and impact           │ 
    └────┬───────────────────────────────────┘ 
         │ 
         ▼ 
    ┌────────────────────────────────────────┐ 
    │  RATE ACTIVITY                         │ 
    │  - Enter rating (0-100%)               │ 
    │  - Provide detailed remarks            │ 
    │  - Assess based on criteria            │ 
    └────┬───────────────────────────────────┘ 
         │ 
         ▼ 
    ┌────────────────────────────────────────┐ 
    │  SUBMIT RATING                         │ 
    │  Status: RATED                         │ 
    │  ↓                                     │ 
    │  Email to Action Officer & Supervisor  │ 
    │  ↓                                     │ 
    │  Activity Complete!                    │ 
    │  ↓                                     │ 
    │  Contributes to:                       │ 
    │  - Evaluation statistics               │ 
    │  - Quality trends                      │ 
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    │  - Performance metrics                 │ 
    └────────────────────────────────────────┘ 

 

Access Permissions Summary 

What You CAN Access 

Feature Access Level Description 

Dashboard Full Access Your personal dashboard with evaluation metrics 

My Activities Full Access Create, view, implement, submit YOUR activities 

Evaluation Full Access Access ALL workplans and rate approved activities 

All Workplans View Only View all workplans system-wide (Evaluator-Specific) 

All Approved Activities View & Rate View and rate any approved activity (Evaluator-Specific) 

Duty Instructions View Only View duty instructions assigned to you 

Reports Standard Access View reports on your activities and evaluations 

Profile Management Full Access Update your personal information 

What You CANNOT Access 

Feature Restriction Who Can Access 

Admin Panel No Access Administrators only 

User Management No Access Administrators only 

Workplan Creation No Access Administrators only 

SME Management No Access Administrators only 

Supervised Activities No Access Supervisors only 

Activity Approval No Access Supervisors only 
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Activity Permissions 

Action Your Activities Other Activities 

Create Activity  Yes N/A 

View Activities  Yes (own only)  Yes (approved activities only) 

Implement Activities  Yes (own only)  No 

Submit for Review  Yes (own only) N/A 

Approve Activities  No  No (Supervisor only) 

Rate Activities  No (own activities)  Yes (approved activities) 

Delete Pending Activities  Yes (own only)  No 

Edit Active Activities  Yes (own only)  No 

Evaluation Permissions 

Action Permission 

View All Workplans  Yes (system-wide) 

View Approved Activities  Yes (all branches) 

Rate Approved Activities  Yes 

Update Ratings  Yes (your ratings only) 

Rate Own Activities  No (conflict of interest) 

View Evaluation Reports  Yes 

Report Permissions 

Report Type Access 

My Activity Reports  Full Access 

Evaluation Reports  Full Access (Evaluator-Specific) 

Statistics Dashboard  Standard Access 
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Report Type Access 

Workplan Reports  Limited Access (view only) 

Corporate Plan Reports  No Access 

HR Reports  No Access 

 

Part 2: Feature-by-Feature Documentation 

 

Activity Management Features 

As an Evaluator, you have all the activity management capabilities of a Regular User. You can create, 

implement, and submit your own activities. 

Feature: Activity Creation & Management (Your Own Activities) 

Feature Description: 

As an Evaluator, you can create and manage your own activities just like a Regular User. These are activities 

that YOU will implement in the field. You must submit these to YOUR supervisor for approval, and they 

will be rated by ANOTHER evaluator (not you). 

Important Note: This section covers YOUR OWN activities. For rating activities implemented by others, 

see the "Evaluation Features" section. 

Purpose and Benefits: 

 Allows you to implement activities in addition to evaluation duties 

 Maintains your field implementation skills 

 Provides firsthand understanding of implementation challenges 

 Demonstrates evaluation standards through your own work 

 Contributes to organizational objectives 

How to Access This Feature: 

1. From Dashboard, click "My Activities" in the left sidebar 

2. Click "Create Activity" button 

How to Use This Feature: 
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The process is identical to Regular Users. Please refer to the Regular User Tutorial for detailed instructions 

on: 

 Creating activities 

 Implementing activities (all 7 types) 

 Submitting activities for review 

 Responding to supervisor feedback 

Key Differences for Evaluators: 

 You assign YOUR supervisor (not yourself) when creating activities 

 You CANNOT rate your own activities (conflict of interest) 

 Your activities are rated by another evaluator 

 You should maintain high quality standards to demonstrate evaluation criteria 

Additional Important Information: 

Tips and Best Practices: 

 Lead by example - maintain high quality in your own activities 

 Apply evaluation criteria to your own work before submitting 

 Balance your time - don't neglect evaluation duties for implementation 

 Use your experience - apply lessons learned from evaluating others' activities 

 Document thoroughly - provide the kind of evidence you look for when evaluating 

Common Mistakes to Avoid: 

 Don't try to rate your own activities (system prevents this) 

 Don't neglect your evaluation duties to focus on your own activities 

 Don't set lower standards for yourself than for others 

Permissions: 

 As Evaluator: You have the same permissions for YOUR activities as Regular Users 

 You cannot rate your own activities 

 You must submit to YOUR supervisor 

 Another evaluator will rate your activities 
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Evaluation Features 

This is the MOST IMPORTANT feature for your evaluation role. Here you access workplans, view 

approved activities, and provide independent quality assessment through rating. 

Feature: Accessing Workplans and Rating Activities 

Feature Description: 

The Evaluation feature allows you to access ALL workplans across the system, view approved activities 

within those workplans, assess implementation quality, and provide percentage-based ratings (0-100%) with 

detailed feedback. 

Purpose and Benefits: 

 Provides independent quality assessment of activities 

 Measures effectiveness and impact achieved 

 Verifies data quality and accuracy 

 Identifies best practices and lessons learned 

 Supports evidence-based decision making 

 Enables continuous improvement through feedback 

 Ensures accountability for results 

 Facilitates performance measurement 

How to Access This Feature: 

1. From Dashboard, click "Evaluation" in the left sidebar 

2. You'll see the Evaluation page with list of ALL workplans (system-wide) 

3. Click "View Activities" on a workplan to see its activities 

4. Click "View Outputs" on an activity to see implementation details 

5. Click "Rate Activity" to provide rating 

How to Use This Feature: 

Accessing Workplans for Evaluation 

Step 1: Navigate to Evaluation 

 Dashboard → Evaluation 

Step 2: View All Workplans 

 See list of ALL workplans across the entire system 
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 Workplans from all branches and supervisors are visible 

 Workplan details shown: 

o Workplan title 

o Branch 

o Supervisor 

o Start and end dates 

o Status 

o Activity count 

Step 3: Filter Workplans (Optional) 

 Status Filter: Show In Progress, Completed, etc. 

 Branch Filter: Focus on specific branch 

 Date Range Filter: Show workplans within date range 

 Search Box: Search by workplan title 

Step 4: Select Workplan 

 Click "View Activities" on any workplan 

 Opens list of activities within that workplan 

Viewing Activities for Rating 

Step 1: View Activities in Workplan 

 See list of all activities within the selected workplan 

 Activity details shown: 

o Activity code and title 

o Target output 

o Budget 

o Status 

o Action Officer 

Step 2: Filter by Status 

 Filter by "Approved" - Activities ready for rating (PRIORITY) 

 Filter by "Rated" - Activities already rated 

 Filter by other statuses - Pending, Active, Submitted (not ready for rating) 

Step 3: Identify Activities Ready for Rating 

 Focus on activities with status "Approved" 
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 These have been approved by supervisor and are ready for evaluation 

 Activities with other statuses cannot be rated yet 

Step 4: Select Activity to Rate 

 Click "View Outputs" on an approved activity 

 Opens Activity Outputs page with implementation details 

Reviewing Activity Implementation 

Step 1: Review Basic Information 

 Activity code, title, description 

 Activity type (7 types) 

 Target output 

 Location (province, district, LLG, village) 

 GPS coordinates 

 Start and end dates 

 Budget allocated vs. actual cost 

 Strategic plan linkages 

Step 2: Review Implementation Details 

Type-Specific Information: 

Review the implementation details specific to the activity type: 

For Documents: 

 Document title, type, description 

 Number of copies produced 

 Distribution method and recipients 

 Document file uploaded 

For Trainings: 

 Training topic, curriculum, duration 

 Trainer information and qualifications 

 Participant list (names, gender, age, villages) 

 Total participants 

 Training photos and materials 

 Signing sheet 

For Meetings: 



AMIS – TUTORIAL 

20 | Page BY: Noland Gande V 2.0 10-2025 

 

 Meeting date, time, type, venue 

 Participant list (names, organizations, positions) 

 Meeting agenda and minutes 

 Decisions and action items 

 Meeting attachments 

For Agreements: 

 Agreement type, title, description 

 Signing parties information 

 Agreement dates (signing, effective, expiration) 

 Agreement value 

 Signed agreement document 

For Inputs: 

 Input type, description, specifications 

 Quantity distributed and unit of measure 

 Beneficiary list (names, gender, villages, inputs received) 

 Total beneficiaries 

 Distribution date, location, method 

 Distribution photos and beneficiary list 

 Cost per beneficiary 

For Infrastructures: 

 Infrastructure type, name, description 

 Technical specifications and dimensions 

 Location and beneficiary communities 

 Contractor information 

 Construction dates and duration 

 Contract value vs. actual cost 

 Construction photos (before, during, after) 

 Completion certificate and inspection reports 

For Outputs: 

 Output type, title, description 

 Target vs. actual output 

 Achievement percentage 

 Quality indicators and assessment 
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 Output evidence and verification documents 

Step 3: Review Evidence 

Photos: 

 Check quality and clarity of photos 

 Verify photos show the activity implementation 

 Assess if photos match the description 

 Count number of photos (minimum 3-5 expected) 

 Look for before/during/after photos (for infrastructures) 

Documents: 

 Review all uploaded documents 

 Check documents are readable and complete 

 Verify documents support the implementation 

 Assess relevance and quality of documents 

Signing Sheets/Distribution Lists: 

 Review signed attendance sheets (trainings, meetings) 

 Check beneficiary distribution lists (inputs) 

 Verify signatures are present 

 Cross-check with participant/beneficiary data 

Step 4: Review Beneficiary Data 

For activities with beneficiaries: 

 Check beneficiary count is realistic 

 Verify names are not duplicates 

 Check gender distribution is recorded 

 Verify villages/communities are specified 

 Ensure data matches signing sheets/distribution lists 

 Assess if beneficiary reach is appropriate for budget 

Quality Indicators: 

  Realistic numbers (not suspiciously round) 

  No duplicate names 

  Complete information (gender, village) 



AMIS – TUTORIAL 

22 | Page BY: Noland Gande V 2.0 10-2025 

 

  Matches evidence (photos, signing sheets) 

  Appropriate for activity type and budget 

Step 5: Review Cost Information 

 Check actual cost is recorded 

 Verify cost is realistic for the activity 

 Compare cost to budget 

 Assess cost-effectiveness 

 Check cost breakdown if provided 

Cost Assessment: 

 Cost per beneficiary (for trainings, inputs) 

 Cost per unit (for infrastructures, outputs) 

 Budget utilization (actual vs. allocated) 

 Value for money (impact vs. cost) 

Step 6: Assess Strategic Alignment 

 Review linkages to MTDP, NASP, Corporate Plans 

 Assess if linkages are appropriate 

 Verify activity contributes to strategic objectives 

 Check if target output aligns with plan indicators 

Rating an Activity 

Step 1: Click "Rate Activity" Button 

 Located on Activity Outputs page 

 Opens rating form 

Step 2: Apply Evaluation Criteria 

Use the following criteria to determine rating: 

1. Evidence Quality (30% weight) 

 Excellent (27-30 points): Comprehensive photos and documents, clear evidence of implementation 

 Good (21-26 points): Adequate photos and documents, sufficient evidence 

 Fair (15-20 points): Minimum photos and documents, basic evidence 

 Poor (0-14 points): Missing or inadequate evidence 
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2. Data Quality (25% weight) 

 Excellent (23-25 points): Complete, accurate, realistic beneficiary/participant data 

 Good (18-22 points): Mostly complete and accurate data 

 Fair (13-17 points): Some data gaps or inconsistencies 

 Poor (0-12 points): Incomplete, inaccurate, or unrealistic data 

3. Implementation Quality (25% weight) 

 Excellent (23-25 points): Implementation exceeds expectations, high quality 

 Good (18-22 points): Implementation meets expectations, good quality 

 Fair (13-17 points): Implementation meets minimum requirements 

 Poor (0-12 points): Implementation below standards 

4. Impact/Achievement (20% weight) 

 Excellent (18-20 points): Significant impact, exceeds target output 

 Good (14-17 points): Good impact, meets target output 

 Fair (10-13 points): Moderate impact, partially meets target 

 Poor (0-9 points): Limited impact, does not meet target 

Total Rating = Sum of all criteria (0-100%) 

Rating Ranges: 

 81-100%: Excellent - Outstanding implementation 

 61-80%: Good - Solid implementation 

 41-60%: Fair - Acceptable implementation 

 0-40%: Poor - Needs significant improvement 

Step 3: Enter Rating Percentage 

Rating Field (Required): 

 Rating Percentage: Enter value from 0 to 100 

 Based on evaluation criteria above 

 Be objective and fair 

 Use consistent standards 

Step 4: Provide Detailed Remarks (Required) 

Remarks Field (Required): 
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 Rating Remarks: Provide comprehensive feedback 

What to Include in Remarks: 

1. Strengths (What was done well): 

 Highlight good practices 

 Recognize quality evidence 

 Acknowledge impact achieved 

 Commend thoroughness 

2. Areas for Improvement (What could be better): 

 Identify gaps or weaknesses 

 Suggest specific improvements 

 Provide constructive guidance 

 Recommend best practices 

3. Specific Observations: 

 Comment on evidence quality 

 Note data accuracy 

 Assess implementation approach 

 Evaluate cost-effectiveness 

4. Recommendations: 

 Suggest actions for future activities 

 Recommend training or support needs 

 Identify lessons learned 

 Propose improvements 

Example Remarks: 

For High Rating (81-100%): 

Rating: 92% 
 
Strengths: 
- Excellent implementation with comprehensive evidence. Training was well-organized 
with clear curriculum and qualified trainer. 
- Participant list is complete and accurate with 48 farmers (28 male, 20 female) from 6 
villages. 
- High-quality photos clearly show training sessions, practical demonstrations, and 
participant engagement. 
- Signed attendance sheet matches participant list. 
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- Good cost-effectiveness at 250 PGK per participant. 
 
Areas for Improvement: 
- Consider adding follow-up plan to track participant application of skills learned. 
- Include pre/post-test results to measure learning outcomes in future trainings. 
 
Recommendations: 
- This training serves as an excellent model for future capacity building activities. 
- Consider documenting training methodology for replication in other districts. 
 
Overall: Outstanding implementation that demonstrates significant impact and high 
quality standards. 

For Medium Rating (61-80%): 

Rating: 72% 
 
Strengths: 
- Good implementation with adequate evidence. Input distribution reached 85 farmers 
across 4 villages. 
- Beneficiary list is complete with names, gender, and villages recorded. 
- Distribution photos show beneficiaries receiving inputs. 
- Signed distribution list is included. 
 
Areas for Improvement: 
- Photo quality could be better - some photos are blurry or unclear. 
- Beneficiary list shows 85 farmers but signed distribution list shows only 78 
signatures - please verify actual number. 
- Cost information is missing - please record actual cost incurred. 
- GPS coordinates not provided - recommend recording location for future activities. 
 
Recommendations: 
- Take clearer photos during distribution events. 
- Ensure beneficiary counts match across all documents. 
- Always record actual costs for financial tracking. 
- Use GPS to record distribution locations for mapping. 
 
Overall: Good implementation with room for improvement in documentation and data 
accuracy. 

For Low Rating (41-60%): 

Rating: 55% 
 
Strengths: 
- Activity was implemented and some evidence is provided. 
- Beneficiary list includes 42 names. 
 
Areas for Improvement: 
- Evidence is inadequate - only 2 photos uploaded and quality is poor. 
- Beneficiary list has several duplicate names (John Kila appears 3 times). 
- Gender information is missing for most beneficiaries. 
- Village information is incomplete. 
- No signed distribution list provided. 
- Cost information is missing. 
- Photos do not clearly show the distribution event. 
 
Recommendations: 
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- Upload at least 5 clear photos showing distribution process and beneficiaries. 
- Remove duplicate names from beneficiary list and verify actual count. 
- Complete gender and village information for all beneficiaries. 
- Obtain and upload signed distribution list. 
- Record actual cost incurred. 
- Ensure photos clearly document the activity. 
 
Overall: Implementation needs significant improvement in documentation and data 
quality. Please address these issues in future activities. 

Step 5: Click "Submit Rating" 

 System validates rating (0-100) and remarks (required) 

 Rating is saved 

 Activity status changes to "Rated" 

 Rating percentage and remarks are recorded 

 Rated by (your name) and rated at (timestamp) are logged 

 Email notifications sent to action officer and supervisor 

 Success message confirms rating submission 

Updating a Rating 

If you need to revise a rating: 

Step 1: Navigate to Rated Activity 

 Evaluation → Rated Activities 

 Find the activity you want to update 

 Click "View Outputs" 

Step 2: Click "Rate Activity" Again 

 Opens rating form with current rating 

Step 3: Modify Rating and/or Remarks 

 Update rating percentage if needed 

 Revise or add to remarks 

 Explain reason for update in remarks 

Step 4: Click "Submit Rating" 

 Updated rating is saved 

 Previous rating is logged in history 

 Email notifications sent about update 
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Note: Only update ratings when necessary (new information, error correction) 

Tracking Your Evaluation Activity 

From Evaluation: 

 Use "Rated Activities" filter to see activities you've rated 

 Use "Pending Rating" filter to see activities awaiting rating 

 Monitor your evaluation progress 

From Dashboard: 

 Pending Rating count shows activities needing evaluation 

 Rated by Me count shows activities you've rated 

 Average Rating shows your average rating percentage 

How This Feature Appears in Reports: 

Evaluation data appears in: 

1. Evaluation Reports 

o List of all activities you've rated 

o Rating distribution (excellent, good, fair, poor) 

o Average rating by activity type 

o Average rating by branch 

o Evaluation trends over time 

2. Activity Reports 

o Rating percentage shown for each activity 

o Your evaluation remarks displayed 

o Rated by and rated at information 

3. Statistics Dashboard 

o Count of rated activities 

o Average rating across all activities 

o Rating distribution charts 

Additional Important Information: 

Tips and Best Practices: 

 Be objective - rate based on evidence, not assumptions 

 Be consistent - apply same criteria to all activities 

 Be thorough - review all evidence before rating 

 Be fair - recognize both strengths and weaknesses 
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 Be constructive - provide helpful feedback, not just criticism 

 Be specific - list exactly what was good or needs improvement 

 Be timely - rate within 3-7 days of approval 

 Be independent - avoid bias or conflicts of interest 

 Document thoroughly - provide detailed remarks 

 Use criteria - apply evaluation criteria consistently 

Common Mistakes to Avoid: 

 Don't rate without reviewing all evidence 

 Don't provide ratings without detailed remarks 

 Don't use only extreme ratings (0 or 100) 

 Don't let personal relationships affect ratings 

 Don't delay evaluation - rate promptly 

 Don't rate your own activities (conflict of interest) 

 Don't ignore missing evidence or data gaps 

 Don't be too lenient or too strict - be fair 

 Don't forget to check beneficiary data accuracy 

Troubleshooting: 

 Can't access evaluation: Check you have evaluator capability 

 Can't rate activity: Check activity status is "Approved" 

 Rating not saving: Check rating is between 0 and 100 and remarks are provided 

 Can't see all workplans: Refresh page or check permissions 

 Can't rate own activity: System prevents this (conflict of interest) 

Related Features: 

 Activity Management: Understanding implementation helps you evaluate better 

 Reports: Your evaluation data feeds into reports 

 Dashboard: Quick view of evaluation metrics 

Permissions: 

 As Evaluator: You can rate ANY approved activity (except your own) 

 You can update your ratings if needed 

 You can view all workplans and approved activities system-wide 

 You cannot rate unapproved activities 

 You cannot rate your own activities 
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Email Notifications: 

 On rating: Action officer receives notification 

 On rating: Supervisor receives notification 

 On rating update: Notifications sent again with update 

Data Validation: 

 Rating must be numeric between 0 and 100 

 Remarks are required (cannot be empty) 

 Activity must have status "Approved" to be rated 

 Cannot rate own activities (system prevents this) 

Business Logic: 

 Only "Approved" activities can be rated 

 Rating changes status to "Rated" 

 Rating percentage is stored as numeric value 

 Remarks are stored as text 

 Rating history is maintained (previous ratings logged) 

 Email notifications are sent asynchronously 

 Conflict of interest prevention (cannot rate own activities) 

 

Duty Instructions Features 

Duty Instructions are specific tasks assigned to you. As an Evaluator, you receive duty instructions just like 

Regular Users. 

Feature: Viewing and Managing Duty Instructions 

Feature Description: 

Duty Instructions provide a system for receiving and tracking work assignments. Each duty instruction 

contains multiple instruction items (specific tasks) that you need to complete. 

Purpose and Benefits: 

 Provides clear task assignments 

 Sets expectations for your work 

 Establishes deadlines 

 Enables task-level tracking 
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 Supports accountability 

 Facilitates communication with your supervisor 

How to Access This Feature: 

1. From Dashboard, click "Duty Instructions" in the left sidebar 

2. You'll see the Duty Instructions Index page with all instructions assigned to you 

How to Use This Feature: 

The process is identical to Regular Users. Please refer to the Regular User Tutorial for detailed instructions 

on: 

 Viewing duty instructions 

 Reviewing instruction items 

 Completing tasks 

 Reporting completion 

Key Points for Evaluators: 

 You receive duty instructions from YOUR supervisor 

 Complete duty instructions alongside your evaluation duties 

 Prioritize based on deadlines and importance 

 Report completion promptly 

Additional Important Information: 

Tips and Best Practices: 

 Balance your time - manage evaluation duties and assigned tasks 

 Prioritize - urgent evaluations may take precedence over some tasks 

 Communicate - inform your supervisor if you need deadline extensions 

 Track progress - monitor pending and completed tasks 

 

Reporting Features 

Reports provide insights into your work and your evaluation activity. As an Evaluator, you have access to 

evaluation-specific reports. 

Feature: Viewing Reports (Evaluation-Specific) 

Feature Description: 
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The Reporting feature allows you to view various reports about your activities and your evaluation activity. 

Reports help you track progress, demonstrate achievements, and identify quality trends. 

Purpose and Benefits: 

 Tracks your activity implementation progress 

 Monitors your evaluation activity 

 Shows rating distribution and trends 

 Demonstrates evaluation impact 

 Identifies quality patterns across activities 

 Supports performance reviews 

 Provides data for management reporting 

How to Access This Feature: 

1. From Dashboard, click "Reports" in the left sidebar 

2. Select the type of report you want to view: 

o My Activity Reports - Your own activities 

o Evaluation Reports - Your evaluation activity (Evaluator-Specific) 

o Statistics - Your data + evaluation data 

How to Use This Feature: 

Viewing My Activity Reports 

Purpose: Track YOUR OWN activities (that you created and implemented) 

Steps: 

1. Navigate to Reports → My Activity Reports 

2. Apply filters (date range, type, status) 

3. Click "Generate Report" 

4. Review your activity metrics and details 

5. Export PDF if needed 

What You See: 

 Your activities only 

 Activity status distribution 

 Budget vs. cost for your activities 

 Your performance metrics 
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Viewing Evaluation Reports (Evaluator-Specific) 

Purpose: Track your evaluation activity and rating trends 

Steps: 

1. Navigate to Reports → Evaluation Reports 

2. Apply filters: 

o Date Range 

o Activity Type 

o Rating Range 

o Branch 

3. Click "Generate Report" 

4. Review evaluation metrics 

What You See: 

 All activities you've rated 

 Rating distribution by range: 

o Excellent (81-100%) 

o Good (61-80%) 

o Fair (41-60%) 

o Poor (0-40%) 

 Average rating by activity type 

 Average rating by branch 

 Evaluation trends over time 

 Number of activities rated per month 

Key Metrics: 

 Total Activities Rated: Count of all activities you've evaluated 

 Average Rating: Your average rating percentage 

 Rating Distribution: Breakdown by rating range 

 Activities by Type: Distribution across 7 types 

 Activities by Branch: Distribution across branches 

 Evaluation Timeline: Ratings over time 

Using the Report: 

 Identify quality trends: Which activity types have highest ratings? 

 Identify support needs: Which branches need quality improvement? 
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 Track consistency: Is your average rating fair and consistent? 

 Recognize excellence: Which activities demonstrate best practices? 

 Plan training: Address common quality issues identified 

Viewing Statistics Dashboard 

Purpose: View real-time analytics of your work and evaluation activity 

Steps: 

1. Navigate to Reports → Statistics 

2. Apply filters (date range) 

3. Review dashboard sections 

What You See: 

 Your Activities: Metrics for activities you created 

 Evaluation Activity: Metrics for activities you've rated 

 Rating Trends: Visual charts of rating distribution 

 Quality Indicators: Trends in quality over time 

Key Sections: 

 Summary cards (activity counts, average rating) 

 Rating distribution (pie chart) 

 Activity type distribution 

 Monthly evaluation trends 

 Quality trends over time 

How This Feature Appears in Reports: 

Reports are the feature itself - they display your data and evaluation data in various formats. 

Additional Important Information: 

Tips and Best Practices: 

 Review reports monthly to track evaluation activity 

 Use evaluation reports to identify quality trends 

 Export reports for management updates 

 Share insights with management for improvement initiatives 

 Use filters to focus on specific periods or activity types 

 Track trends over time to measure quality improvement 
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 Identify patterns for training and support needs 

Common Mistakes to Avoid: 

 Don't forget to apply filters before exporting 

 Don't ignore quality trends 

 Don't use reports to criticize - use them to improve 

 Don't export without reviewing data first 

Troubleshooting: 

 No data showing: Check filters aren't too restrictive 

 Export fails: Check browser pop-up blocker 

 Charts not displaying: Refresh page or check browser 

 Slow loading: Reduce date range 

Related Features: 

 Evaluation: Data feeds into reports 

 Dashboard: Quick view of key metrics 

Permissions: 

 As Evaluator: You see YOUR activities + YOUR evaluation activity 

 You cannot see other evaluators' ratings 

 You have evaluation-specific reports 

 

Dashboard Features 

Your dashboard is your command center showing both your personal work and your evaluation 

responsibilities. 

Feature: Evaluator Dashboard Metrics 

Feature Description: 

The Evaluator Dashboard provides real-time metrics about your activities and your evaluation activity, with 

quick access to key features. 

Purpose and Benefits: 

 Instant visibility of your work and evaluation status 
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 Quick access to priority actions (pending ratings) 

 Tracks your pending and completed work 

 Shows evaluation activity at a glance 

 Motivates through progress visualization 

 Supports daily work planning 

How to Access This Feature: 

 Automatically displayed after login 

 Click "Dashboard" in left sidebar anytime 

How to Use This Feature: 

Understanding Evaluator Dashboard Widgets 

My Activities Widget: 

 Shows count of YOUR activities by status 

 Click counts to filter your activities 

 Click "Create New Activity" for quick access 

Evaluation Activities Widget (Evaluator-Specific): 

 Total Approved Activities: All approved activities system-wide 

 Pending Rating: Approved activities not yet rated (PRIORITY) 

 Rated by Me: Activities you've rated 

 Average Rating: Your average rating percentage 

 Click "View Activities to Rate" to go directly to pending ratings 

My Tasks Widget: 

 Shows pending and completed duty instructions 

 Click "View All Tasks" to see duty instructions 

Recent Evaluations Widget (Evaluator-Specific): 

 Shows your 5 most recent evaluations 

 Displays activity title, rating, and date 

 Click any evaluation to view details 

Evaluation Statistics Widget (Evaluator-Specific): 

 Rating Distribution: Breakdown by rating range 
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o Excellent (81-100%) 

o Good (61-80%) 

o Fair (41-60%) 

o Poor (0-40%) 

 Visual Chart: Pie chart showing distribution 

 Click "View Evaluation Report" for detailed metrics 

Using Quick Actions 

From Dashboard: 

 Create New Activity → Opens activity creation form 

 View Activities to Rate → Goes to Evaluation (Pending Rating filter) 

 View All Tasks → Goes to Duty Instructions page 

 View Evaluation Report → Goes to Evaluation Reports 

Monitoring Your Responsibilities 

Daily Check (Priority Order): 

1. Pending Rating count - Activities awaiting your evaluation (DO THIS FIRST) 

2. My Activities Submitted count - Your activities awaiting approval 

3. Average Rating - Ensure fair and consistent evaluation 

4. My Tasks - Duty instructions to complete 

5. Recent Evaluations - Review your recent ratings 

Weekly Review: 

1. Review rating distribution by range 

2. Check average rating for consistency 

3. Identify quality trends 

4. Track your own activity progress 

5. Plan upcoming evaluations 

How This Feature Appears in Reports: 

Dashboard metrics are derived from your activity data and evaluation data, and appear in detailed reports. 

Additional Important Information: 

Tips and Best Practices: 

 Check dashboard daily when you log in 
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 Prioritize pending ratings - don't let them accumulate 

 Use quick actions for efficiency 

 Monitor rating distribution to ensure fair evaluation 

 Track your own progress alongside evaluation duties 

 Review average rating for consistency 

Common Mistakes to Avoid: 

 Don't ignore high pending rating counts 

 Don't neglect your own activities for evaluation duties 

 Don't forget to check rating distribution 

 Don't overlook quality trends 

Permissions: 

 As Evaluator: You see YOUR data + YOUR EVALUATION data on dashboard 

 Dashboard is personalized to your work and evaluation activity 

 

Conclusion 

Congratulations! You've completed the AMIS Evaluator Tutorial. You now have comprehensive knowledge 

of all features available to you as an Evaluator. 

Key Takeaways 

Your Dual Role: 

1. As an Implementer: Create and implement your own activities 

2. As an Evaluator: Provide independent quality assessment of approved activities 

Your Responsibilities: 

 Rate approved activities based on objective criteria 

 Provide constructive feedback to improve quality 

 Maintain independence and objectivity 

 Apply consistent evaluation standards 

 Identify quality trends and patterns 

 Support continuous improvement through feedback 

 Create and implement your own activities 

 Complete duty instructions assigned to you 
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Your Capabilities: 

 All Regular User Features: Everything a Regular User can do 

 Access All Workplans: View workplans system-wide 

 Rate Approved Activities: Provide percentage-based ratings (0-100%) 

 Provide Evaluation Feedback: Give detailed, constructive remarks 

 Update Ratings: Revise ratings if needed 

 View Evaluation Reports: Access reports on evaluation activity 

Your Evaluation Workflow 
APPROVED → REVIEW → ASSESS → RATE 
              ↓         ↓        ↓ 
         Check:   Apply:   Provide: 
         - Evidence  Criteria  Rating (0-100%) 
         - Data      - Evidence  + Detailed 
         - Quality   - Data      Remarks 
         - Impact    - Implementation 
                     - Impact 
                         ↓ 
                     RATED 
                         ↓ 
                  Email Notifications 
                         ↓ 
                  Contributes to: 
                  - Quality metrics 
                  - Performance data 
                  - Continuous improvement 

Next Steps 

1. Check Pending Ratings Daily - This is your top priority 

2. Review Thoroughly - Examine all evidence before rating 

3. Apply Criteria Consistently - Use evaluation criteria for all activities 

4. Provide Constructive Feedback - Help improve future implementation 

5. Maintain Independence - Evaluate objectively without bias 

6. Track Quality Trends - Identify patterns for improvement 

7. Lead by Example - Maintain high quality in your own activities 

Evaluation Criteria Checklist 

Before rating any activity, assess: 

 Evidence Quality (30%): 

 Photos clearly show implementation 

 Documents are complete and relevant 
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 Signing sheets/distribution lists included 

 Evidence supports the implementation 

 Data Quality (25%): 

 Beneficiary/participant data is complete 

 Data is accurate and realistic 

 No duplicates or inconsistencies 

 Data matches evidence 

 Implementation Quality (25%): 

 Implementation meets or exceeds standards 

 Approach is appropriate for activity type 

 Quality of execution is high 

 Resources used effectively 

 Impact/Achievement (20%): 

 Target output achieved or exceeded 

 Significant impact demonstrated 

 Beneficiary reach is appropriate 

 Value for money achieved 

Feedback Best Practices 

When providing evaluation remarks: 

 Be Specific: 

 List exactly what was good or needs improvement 

 Provide clear examples 

 Reference specific evidence 

 Be Constructive: 

 Focus on improvement, not criticism 

 Provide guidance on how to improve 

 Recognize strengths and achievements 

 Be Objective: 
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 Base feedback on evidence, not assumptions 

 Apply consistent standards 

 Avoid bias or personal preferences 

 Be Comprehensive: 

 Address all evaluation criteria 

 Comment on strengths and weaknesses 

 Provide recommendations for future activities 

Getting Help 

If you encounter issues: 

1. Check this tutorial for guidance 

2. Review error messages carefully 

3. Contact your supervisor for evaluation questions 

4. Contact IT support for technical issues 

5. Refer to other documentation in dev_guide/ folder 

Best Practices Summary 

 Do: 

 Rate pending activities promptly (within 3-7 days) 

 Provide detailed, constructive feedback 

 Apply evaluation criteria consistently 

 Review all evidence thoroughly 

 Maintain independence and objectivity 

 Track quality trends and patterns 

 Lead by example with your own activities 

 Communicate insights to management 

 Update ratings when necessary 

 Celebrate excellence and best practices 

 Don't: 

 Delay evaluations unnecessarily 

 Rate without reviewing evidence 

 Provide ratings without detailed remarks 

 Let personal relationships affect ratings 
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 Use only extreme ratings (0 or 100) 

 Rate your own activities (conflict of interest) 

 Ignore missing evidence or data gaps 

 Be too lenient or too strict - be fair 

 Forget to check beneficiary data accuracy 

 Neglect your own activities for evaluation duties 

System Goal Reminder 

Always remember the primary objective: Monitor and Measure the effectiveness of activities 

implemented and how they contribute to achieving the targets in the plans. 

As an Evaluator, you enable this goal by: 

 Providing independent quality assessment of activities 

 Measuring effectiveness and impact achieved 

 Verifying data quality and accuracy 

 Identifying best practices and lessons learned 

 Supporting evidence-based decision making 

 Enabling continuous improvement through feedback 

 Ensuring accountability for results 

Your Impact 

Your role as an Evaluator is crucial to the success of AMIS and the agricultural sector: 

 You ensure quality through independent assessment 

 You measure impact through objective evaluation 

 You enable learning through constructive feedback 

 You maintain standards that ensure data integrity 

 You identify excellence that can be replicated 

 You contribute to national development goals through rigorous evaluation 

Thank you for your dedication to quality and excellence in agricultural development in Papua New 

Guinea! 

 

Thank you for using AMIS! 

Document End 


